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User Interface
The UI in AutoCAD 2012 software just
gets easier and easier to work with.

For those of you who like to key in commands—save time with AutoComplete!
As you key in commands, AutoCAD
automatically completes the entry. If
you pause, a list of all possible commands and system variables displays
for easy selection.

You’ll also notice that the command
history is now displayed with a grey
background color. This can be modified
in Options (Display Tab ->Colors…).

Drawing Window

It’s easier than ever to set up or modify
your viewports, 2D and 3D views and
visual styles directly from the drawing
window (big time saver!)

AutoCAD displays a dark gray background in modelspace (by default). The
Display tab in OPTIONS lets you easily
modify the color.

Control the display of these
in-canvas viewport controls from the
3D Modeling tab of Options.

The grid has been modified to resemble
graph paper (horizontal and vertical
gridlines). You’ll see red and green lines
extending from the UCS to indicate the X
and Y axes when the grid is toggled on.

Quick Access Toolbar
The Workspace menu and SAVEAS have
been added to the Quick Access Toolbar.

Changing the Ribbon
For those of you who would like the
Ribbon to take up less room you’ll
appreciate the pull-down menu that
was added to the ribbon cycle button.
The Minimize to Panel Buttons option
displays large icons for each panel. The
panel will expand when you hover over
the button.
Customize AutoComplete from the command line right click menu (even control
the delay response time).

Put the Layer drop-down list on the
Quick Access Toolbar for speedy access
at all times! A simple right click on the
layer drop down list allows you to easily
add it.

Double click on the – to quickly
display 4 viewports or the previously
specified viewport configuration.
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Implied Selection

Select Similar

Enhancements allow you to include Fold
panels. As you change the size of your
AutoCAD window or add and remove
panels from a tab, Fold panels resize
horizontally to fill the available space.
You can specify a default, maximum and
minimum button size for each panel in
the CUI.

When selecting objects (outside of a
command) you’ll find the additional
options of Wpolygon, Cpolygon and
Fence appear.

The Select Similar tool allows you to
quickly select objects of the same type
and properties (much faster than Quick
Select). Find this tool in the right-click
menu when one or more objects are
selected.

Navigation

PICKAUTO set to 2 allows you to start a
window even when picking on an object
(for those crowded drawings). This only
works outside of a command.

The Navigation bar replaces the navigation tools that were previously available
on the Status bar. This bar resides on the
right side of the screen by default and
includes Autodesk® SteeringWheels®,
ViewCube®, ShowMotion®, Pan, Zoom
and Orbit tools.
The Navigation bar also includes
support for 3D Connexion devices
when the 3D Connexion system
driver is present.

Can’t decide whether you prefer pick and
drag or picking two points to define a
window? The new PICKDRAG setting of
2 combines both options.

The ViewCube supports the 2D
Wireframe visual style (you might find
the clockwise and counter-clockwise
controls useful for rotating the viewpoint
in the 2D plane).

UCS Icon
Each axis has its own color: X for red, Y
for green and Z for blue.

Now SNAPMODE temporarily turns
off when selecting objects.

Use the Settings option to specify which
properties to filter (only available when
you enter SELECTSIMILAR from the
command line).

You can select more than one
object to match with Select Similar. For
example, if the Layer filter is enabled
and you select a circle and a line that
reside on two different layers, AutoCAD
will find all of the objects that match the
circle AND all of the objects that match
the line.

5

Object Selection and Creation Tools

User Interface

4

7

6

Control object visibility independent
from layer visibility! The Isolate Objects
tool (found in the right-click menu)
displays just the objects selected (everything else is hidden). This makes it easier
to work within complicated drawings.
You can use the Hide Objects tool (also
found in the right click menu) to hide the
objects selected.
Quickly restore the hidden objects with
the End Object Isolation tool.
Use the OBJECTISOLATIONMODE (yikes!) system variable to
control whether object isolation persists
between drawing sessions.

The lightbulb icon in the lower right corner of the status bar indicates whether
object isolation is active in the drawing.
These tools can be VERY valuable
when working in 3D!

PICKADD
For you programmers: the system variable PICKADD has a default value of 2.
The objects selected with the SELECT
command will now remain in a “pickfirst” state after exiting the command.

Selection Cycling

Add Selected

Easily select overlapping objects with
the Selection Cycling tool (controlled
on the status bar). When you select an
object that overlaps other objects,
AutoCAD displays a list of all the overlapping objects. Objects highlight as you
move through the list.

Need to draw an object with the same
type and properties of an existing one?
Use the Add Selected tool to get the
job done in no time! For example, select
a polyline, pick Add Selected from the
right click menu and AutoCAD is ready
to create another polyline with the same
properties. This is a HUGE timesaver!

Selection Cycling can also be very
helpful when working in 3D.

Very helpful when working on other
people’s drawings! For example: use
Add Selected to quickly add in another
dimension with the exact same style and
settings.

Object Selection and Creation Tools

Object Selection and Creation Tools

Object Visibility
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Autodesk Content Explorer

Editing Tools
Drag and drop local folders for searching
from Windows Explorer or use the Add
Watched folder option.

Filter content and switch between
thumbnail and detail views. Drag
content into your current drawing or
open the source file from Content
Explorer.

Speedy searches for all types of content
including blocks, attributes, layers, styles,
etc. Found in the Plug-ins ribbon tab,
Content Explorer can search through

In AutoCAD 2012 multifunctional Grips
have been added to many objects!
Polylines have extra grips to make editing much easier. Secondary grips are
located at the midpoint of each segment.
Hovering over a grip provides several
valuable editing options such as stretch,
add or remove vertex and Convert to
Arc/Line.

Use Add Network Content to specify
computer name or IP address of the
network computers.
Search Autodesk Seek to easily
add online content from a variety of
manufacturers.

Multifunctional Grips

Install the Autodesk Content Service
(found on the AutoCAD 2012 installer)
on network computers to add watched
folders from other computers.
You can only add shared folders.

Editing Tools

Autodesk Content Explorer

thousands of files almost instantaneously including Autodesk® Seek web service
(much faster than Design Center!)
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Look for these powerful grips in lines,
arcs, elliptical arcs, dimensions and
mleaders. 3d faces, edges and vertices
also have them. Just hover over a grip to
access numerous relevant options.
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Groups

Multifunctional grips are even more
powerful when dynamic input is on.

Nudge!
Have you ever wanted to move objects
over by just a few pixels? Use Ctrl and
your arrow keys!

Osnap Enhancements
Added flexibility helps AutoCAD find object snap points to make objects tangent
or perpendicular. Choose from multiple
snap points based on the location of the
cursor.

Copy Improvements
You’ll find a new Array option in the
Copy command. It lets you create a linear, non-associative array on the fly!

A group is a saved set of objects that
you can edit together or separately when
needed. Groups make it easy to manipulate a group of objects as a unit.

Express Tools become “Real”
commands
The NCOPY Express Tool is now a
core AutoCAD command. Copy nested
objects from Xrefs, blocks and DGN
underlays (no need to explode or bind!).
Use the Delete Duplicates tool
(OVERKILL Express Tool) to clean up
your drawing and remove duplicate
geometry.

JOIN Command
You can join lines, arc and polylines to 3D
polylines or splines as long as they are
contiguous. (3D polyline or spline). You
can also join a helix to a spline.
Join now supports standard
selection methods (such as crossing)
or picking objects in any order!

New Blend Tool

Use Shift+Control+A to quickly
turn Grips on and off.

Use the Blend command to create spline
objects between two objects (Modify
panel of the Home ribbon tab).

Fillet and Chamfer
New previews display when passing the
cursor over the second object in the
Fillet/Chamfer commands. Confirm and
change the radius or distance before
completing the command!
Now you can fillet splines!

to optimize polyline segments and/or
combine co-linear objects. The tolerance
value controls the precision by which
OVERKILL will operate.

Control OVERKILL settings in the dialog
box. Specify which object properties
to ignore along with whether or not

Editing Tools

Editing Tools

Groups are in many a CAD guru’s bag
of tricks. Now you’ll find easy access to
groups on the Home tab of the ribbon.
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An associative array treats the entire
array as a single array object (much like
a block). This makes it easy to edit the
properties of the array after the fact.
There are three types of Associative
arrays: rectangular, polar and the new
path option.

2D Associative Arrays
The new visual preview makes it easier
than ever to get your array right the first
time.

It’s easy to manipulate with multifunctional grips or the Properties palette.
The contextual ribbon tab and right
click menu also makes it easy to edit an
associative array. The contextual ribbon
tab and right click menu makes it easy to
edit an array.
Individual items in an array can be
selected and edited by using the Ctrl Key.
Use the new Replace item tool to replace
selected instances with other objects.
The Reset tool returns the items to
their default size and position.

Path Arrays

3D Associative Array

Distribute items evenly along a specified
path. The Measure option is used to
specify a distance between the items.
Use Divide to specify the number of
items. (AutoCAD will space them evenly
along the path.) If the path is modified—
the arrayed objects will follow!

3D Associative Arrays are also very
powerful. Indicate the number of levels
(the number of items needed in the
Z direction) and specify the distance
between levels.

A valid path option is a line, polyline, 3D
polyline, spline, helix arc, circle or ellipse.
Specify whether the arrayed objects
should maintain the starting orientation
or adjust to remain parallel to the path.

Change the appearance of all the arrayed
objects with the Edit Source tool.

Use base point to control the position of the arrayed items relative to the
path.
Explode an array to remove
the associativity.

A distance of 0 between levels
would create all rows at the same
elevation.

Associative Arrays

Associative Arrays
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Associative Arrays
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Helpful Time Savers
External References

Missing SHX and Font Files

Transparency

Passing the cursor over the edge of an
attached image, DWF or PDF will display
a selection preview frame (even when
frames are turned off). You’ll also find
this when you pass your cursor over
geometry inside of attached DWF, PDF,
DGN or DWG files.

You can ignore missing SHX files when
opening a drawing without specifying
a replacement (although text using the
missing SHX files will not be displayed).

You can assign transparency to objects
and layers much like any other property!
Set the transparency to a value between
0 and 90. 0 indicates no transparency
while 90 indicates high transparency.

The new system variable
FRAMESELECTION controls this
behavior.
The External References palette includes
an option to detach data extraction
tables from a drawing. You’ll also find
that the corresponding reference highlights in the External References palette
when selected.
You can easily fade reference
files from the Reference panel on the
Insert tab.

Annotation
Scale Lists
Create a Default Scale List (Options
command, User Preferences tab) that
automatically displays across all of your
drawings.

Text Alignment in Linetypes

Mtext background mask now remembers
the last used fill color and offset. (No
more defaulting to red and 1.5!)

Helpful Time Savers

Helpful Time Savers
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You can now change the gap around
Mleader text in a text frame. You can
also extend the leader line all the way
to the text (rather than ending at the
bounding box).

The option of “U” (for upright) can be
added to your linetypes to maintain linetype readability in any orientation.

Remove Style Overrides has been
added to the right click menu when you
select a dimension.
You’ll find the Transparency property in
all the Layer Dialogs and you can even
assign Transparency per viewport.
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You can also set transparency per object
(which will override the layer transparency setting). Transparency can be
easily found in Properties or on the
Home tab.
The system variable CETRANSPARENCY can be used to set the transparency property for new objects.
SETBYLAYER, Quick Select,
Filter and MATCHPROP now include
Transparency as an option.
You can temporarily turn off transparency, much like lineweights, from the
status bar (this does not affect plotting).

Transparency works great with solid
hatches!
By default Transparency is turned
off for plotting (since it has to rasterize
the drawing which slows down plotting).
Don’t forget to turn it on if you want
your transparencies to plot!

Spline Enhancements
AutoCAD lets you define a spline using
fit point or control vertices (CV).

You can control the Degree of a CV
spline (the number of bends—from 1 to
3—that the spline can take overall).
Use the intuitive grip menu to further
control splines.
Use a CV spline if you plan on creating
3D NURBS surfaces for best results.
SPLINEDIT has been updated to include
more Edit Vertex options like add kinks
or elevate order.
AutoCAD 2012 supports periodic splines
with C2 continuity. The knot parameterization property of a spline is no longer
read-only.
You can now use the Extend
command to extend spline objects!

Layers Improvement
Use the right click menu in the Layer
Properties Manager to quickly freeze
specified layers in all viewports except
the current one (handy!)

Helpful Time Savers

Helpful Time Savers

When drawing a fit spline, you can
specify start and end tangencies, tolerance (how close the spline is to the fit
point) and knot parameterization (which
controls the shape of the curve as it
passes through the fit point)

Hatches and Gradients

The context sensitive Hatch Creation
tab does a great job of making hatching
much easier and more intuitive. As soon
as you execute the Hatch command
you will be asked for an internal point.
(What? No hatch dialog box?) Just
passing your cursor over an eligible area
shows you what the hatch will look like.
Use the Hatch Creation tab to make
changes dynamically.
Even though it looks as though
you created separate hatches as you
clicked—they won’t actually be separate
unless you have “Create Separate
Hatches” selected (found under
Options).

Grips
The Hatch Grip functionality is amazing.
The new center grip allows direct manipulation of hatch objects. Hover over
the grip to stretch, move, or change the
origin, angle or scale.

3D Tips

You’ll also find that it is easy to
manipulate non-associative hatch
patterns with grips!

Send Hatches to Back

UCS Enhancements

Use the HATCHTOBACK command
to move hatches underneath all other
objects. This command is located on the
Modify panel of the Home tab.

Directly manipulate the UCS icon to
easily change the UCS using multifunctional grips. Easily move and align the
origin with objects (including curved
surfaces and solids). Select the UCS icon
and choose from the various menus that
appear as you hover over the grips.

Background Color
Hatches now support background
color—this adds the effect of layered
hatches within one object.
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Hatch Layer
We often want our hatches to all reside
on a specific layer. Now you can set a
default layer for hatches that overrides
the current layer.

UCS icon selectability can
be controlled in the UCS dialog box
(Coordinates panel, View ribbon tab
in the 3D Modeling workspace).
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The 3D Gizmo

Additional controls appear when you
right click over the UCS icon.

A 3D Scale gizmo has been added to
3D Move and 3D Rotate for more 3D
functionality.

Selecting edges, faces and vertices

3D Tips

You can go directly to a specific gizmo
with the 3DMOVE, 3DROTATE and
3DSCALE commands. You’ll find that
the gizmos go directly to the center of
the selection set. (Saving you that extra
step.)
3D Tips

In the past it has been tricky selecting
between an edge, face or vertex. The
Subobject panel on the Home tab makes
quick work of this now! These options
are also available from the right click
menu when no objects are selected.

If you are using a 3D visual style the
gizmo will display when an object is
selected. The Selection panel on the
Home tab makes it easy to change from
one gizmo mode to another.

The UCS icon also displays a
dynamic preview in the UCS command.

3D Object Snaps
A set of 3D Object snaps are in
AutoCAD along with a button on the
status bar to turn them on and off.
A new 3D Autosnap control has
been added in Options so you can distinguish between 2D and 3D Autosnaps
with different colors.

A right click on a gizmo lets you modify
the gizmo’s behavior. Here you can
constrain to a different axis or plane,
relocate it and realign it.
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Solid Modeling

Offset Edge

Updates to EXTRUDE, LOFT, REVOLVE
and SWEEP allow you to select an edge
or face for using as a profile or curve to
create a new surface or solid.

Create an offset curve from a planar face
on a 3D surface or solid. Offset to the
inside or outside using your cursor to
produce a polyline or spline and indicate
sharp or rounded corners.

You are no longer limited to
using planar curves!

Follow this up with Presspull or Extrude
to easily add or remove the bounded
area from a solid.

Found in the Solid tab, the Fillet Edge
and Chamfer Edge tools provide a
dynamic preview and support direct
manipulation by pulling on the
attached grip.

New Chain and Loop Selections:
Selecting contiguous edges and curves
just got so much easier!
SURFPATCH, SURFBLEND, MESHCAP
and FILLETEDGE now detect contiguous
edges with a solid or mesh object (or
within/between surfaces).
A new Loop option (much like a closed
chain) can be found in FILLETEDGE and
CHAMFEREDGE.

Now Presspull repeats so you can
press and pull multiple times in a single
operation.

Use the very cool Autodesk® Inventor®
Fusion technology to easily edit and
validate models from almost any source.
The super friendly and intuitive direct
manipulation capabilities provides direct
modeling for speedy design changes
in 3D.

Without exiting AutoCAD, you can
launch Inventor Fusion, use it to modify
a 3D model and then continue working
on the modified objects in AutoCAD.
You must install Autodesk
Inventor Fusion 2012 to use it.
After installing—it can be found in the
Plug-Ins tab on the Ribbon . When you
select a surface or solid in AutoCAD,
the Edit in Fusion tool is automatically
displayed at the right end of the contextsensitive tab.
In Fusion you can zoom, pan, and orbit
to navigate around your model similar to
AutoCAD. You’ll even find the familiar
Navigation bar and ViewCube.

Autodesk Inventor Fusion

Fillet Edge and Chamfer Edge
3D Tips
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Autodesk Inventor Fusion
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The power in Fusion is the direct editing
capabilities. Intuitively edit and validate
models from almost any source. Click on
a model edge or face to select it for editing. Press the Ctrl key to select multiple
objects (just as you would expect).
The ribbon interface as well as contextsensitive right-click options provides
easy access to relevant editing tools.
With Inventor Fusion you can quickly and
easily insert standard, counter bore or

countersink holes, add or modify fillets
and chamfers along with many other 3D
capabilities. Fusion is very intuitive and
easy to use (and addicting)!
When you are finished editing your
model in Inventor Fusion—return to
AutoCAD by selecting the Return to
AutoCAD tool.

Surface modeling has seen some dramatic improvements. A type of surface—
called a Procedural surface, is actually
associated with its defining geometry.
This makes it easier than ever to digitally
sculpt your designs in 3D.
NURBS surfaces are not associative (and have no history). They have
control vertices that allow you to sculpt
your designs.
The Surface tab provides easy access to
the surface modeling tools.

Surface Creation Tools
There are three analytic surface types
in AutoCAD 2012: Blend, Patch and
Network
The new SURFBLEND command can
be used to create a continuous blend
between two existing surfaces.

SURFPATCH lets you patch an open,
closed-edge object.

Surface Modeling

Autodesk Inventor Fusion
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Surface Modeling
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SURFNETWORK is used to create a surface through a set of curves or between
the edges of other surfaces and solids.

Surface Editing Tools
Use the SURFFILLET tool to create a fillet
between two surface edges.

You can even choose a set of
curves that are not connected to one
another!
SURFOFFSET can be used to create a
new surface by offsetting an existing
one.

A set of analysis tools have been added
into AutoCAD to help you validate the
continuity, curvature and draft angles of
surfaces.
Zebra: Maps stripes onto surfaces
and meshes for analysis. The more the
stripes line up, the higher the continuity
between surfaces.

Use the UNTRIM command to
undo a trimmed surface.
SURFEXTEND is used to extend a surface
by selecting an edge.

Curvature: Displays a color gradient
that indicates high and low areas of
curvature along with unacceptable sudden changes such as bumps, dents and
ripples.

SURFSCULPT creates a solid object
based on the enclosed volume of more
than two intersecting surfaces.

You can convert a surface or solid to
a NURBS surface with the Convert to
NURBS tool. Use Show CV to display
the vertices for editing with the gizmo
along with the other tools on the Control
Vertices panel.
Turn on Surface Associativity when
creating surfaces so the surfaces can be
driven by their defining geometry.

Analysis Tools

You’ll lose any associativity when
you convert to NURBS.

Draft Angle: Displays a color gradient
indicating if there is adequate draft angle
between the part and the mold.

Surface Modeling

Surface Modeling

The very powerful SURFTRIM tool can
be used to create complex edges and
holes.

In the Project Geometry panel you’ll
find tools that let you project geometry
on top of surfaces. AutoTrim is used to
specify if you want surfaces automatically trimmed after a projection.
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3D Model Import
So many file formats—so little time!
Now you can import a much wider variety of file formats including CATIA, NX,
Pro/Engineer, Rhino and SolidWorks.
The data is translated to native
AutoCAD geometry and inserted into
the drawing as blocks. Parts and
assemblies are preserved as nested
blocks. And of course you can edit the
objects. Just explode it first!

The new model documentation commands are found in the Drawing Views
panel of the Annotate ribbon tab.

Specify drafting standards for new drawing views in the Drafting Standard dialog
(lower right corner of the Drawing Views
ribbon panel).
Easily modify drawing views from the
contextual ribbon tab by double-clicking
on a view.
Projected views become the child
in a parent/child relationship and inherit
the parent properties and edits.

Model Documentation
It’s never been easier to go from your
3D models to 2D documentation. You’ll
even find that if you modify the 3D
model—the 2D documentation will
update as well!

Applying Standards

Start with Base View to automatically
display a scaled preview of the model
attached to the cursor. Specify options
such as type, orientation and scale.

Model Documentation

Model Documentation
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Model Documentation

Create projected views from the Base
view (as long as the Type option was set
to Base and Projected) by dragging the
cursor to the desired location. AutoCAD
automatically creates the appropriate
view.
Modify properties for a selected drawing
view using the Properties palette.

Use the multifunctional grip at the
center of each drawing view to stretch
or rotate a view—or break and repair
alignment.
AutoCAD clues you in when the source
model changes (making your drawing
views out of date).

Use the Export Layout tool to
export your finished Drawing views to
model space (found in the right click
menu of the layout tab).
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Point Cloud Tab
You can attach and display point clouds
created from 3D Scanning devices.

Adjust the point density in the Density
slider bar for better performance.

Point Clouds are attached much like
other reference files and can contain up
to 2 billion points!

AutoCAD 2012 has an improved
indexing algorithm for optimized viewing
when changing zoom levels.

You’ll probably want to lock down
the point clouds so the points don’t
move.
You can create geometry from the point
cloud data by snapping to points (the
Node object snap).

The Autodesk Materials Library is now
available online (download and install
when needed). You’ll also find that
it is overall easier to use and better
organized.

Easily create, categorize and open your
own materials library from the Materials
Browser as well. Use the robust search
feature to find specific materials and
then add them to the current drawing.

The Materials Browser makes it easy to
browse and search from over a thousand
materials in the Autodesk Materials
Library. The Materials Browser can
be found on the Render tab of the 3D
Workspaces.

You can easily edit the materials in the
updated Materials Editor. Materials that
have been placed in the drawing will
dynamically update.

Materials

Model Documentation
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Materials
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Added Extras
Autodesk® Exchange for AutoCAD
Get up to date information, videos, plugins and help content delivered to your
AutoCAD workspace from the Autodesk
Exchange. Displayed when you start
AutoCAD 2012—you can also access it
from the upper right corner of the
AutoCAD window.

Nearly 1000 manufacturers and 35,000
products are available on Autodesk Seek
(over 100,000 DWG files).
You can also share your designs by uploading them directly from AutoCAD.

Migration
Tool Palettes (including groups) and
Materials Libraries migrate from previous releases (with better results). You
can also easily return to the default
settings with the new Reset tool found
in the Windows Start menu.

Raster Files
Autodesk Seek
Don’t miss out on the great content
available (for free!) up on Autodesk Seek
service. Easily get to Autodesk Seek from
the Content panel on the Insert tab or
from inside of Design Center.

AutoCAD 2012 accepts more file formats
for attaching: DDS, DOQ,ECW,HDR,
JPEG2000, MrSID, NTF, OpenEXR, and
PSD.
All images from AutoCAD®
Raster Design are automatically
displayed.

You can now specify multiple folders for
PC3, PMP, CBT and STB files in Options.

DGNTM Support
Complex linetypes are now maintained!
To ensure that custom linetypes are
displayed, copy the corresponding .rsc
files to the support path or add the RSC
file path to the search path in AutoCAD
in the Options dialog box (Files tab, Support File Search Path).

DWG Convert
Batch convert drawing files to Release
14, 2000, 2004, 2007 and 2010 with the
DWG Convert tool (DWGCONVERT).
You can save the lists for future use
and specify options such as purging the
drawings.

Use DWGCONVERT to quickly
replace page setups in multiple
drawings!
Autodesk® Vault software now supports
the Sheet Set Manager.
Autodesk Vault is a great means of managing all of your design data. Users check
in and out drawing files from Vault,
which maintains revision information.
Vault is also a powerful data reuse and
collaboration tool (free for subscription
members!).
The right click menu in the Sheet Set
Manager now includes vault options to
log in and out of Vault.

Added Extras

Added Extras

Multiple search paths for plot files
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Have you tried AutoCAD® WS web
service yet? AutoCAD WS lets you view,
edit and share drawings through the web
or mobile device (take your drawings on
the road!).
AutoCAD 2012 makes it easier than ever
to upload your drawings to an AutoCAD
WS server. Set up an automatic upload

to ensure the most recent file is always
posted (Manage Uploads tool).

Use the Open Online tool to access and
edit the drawing online in AutoCAD WS.

View all of your online drawings and
folders with the Online Drawings tool.

You can also upload other types
of files such as images, documents and
spreadsheets (Upload Multiple Files
tool).

AutoCAD WS

AutoCAD WS
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AutoCAD WS
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Autodesk Design Suite 2012 (Standard)
Use the Timeline tool for a detailed
design history.

But wait—it gets even better! Use the
Share Drawing tool to collaborate with
others (even if they don’t have AutoCAD
installed). AutoCAD WS will automatically notify collaborators with an email
invitation.

AutoCAD WS

Give AutoCAD WS a try—did I mention
it’s free*?

Download the free* app for iOS mobile
devices at the App Store. Also available
for the Android.
*Free products and services are subject to the terms
and conditions of the end-user license agreement
that accompanies them.

Designer, Autodesk® Showcase®,
and Autodesk® MudboxTM software.
The Premium version of the suite
adds Autodesk® 3ds Max® Design. The
Ultimate version of the suite also adds
Autodesk® Alias® Design.

Autodesk Design Suite

You can also use the Get Link tool
to embed a link to a drawing in web
pages and documents.

Enhance the power of AutoCAD with
easy-to-use visual communication
solutions. Autodesk Design Suite helps
designers work more creatively, rapidly
evaluate designs in context and effectively communicate and sell ideas. Autodesk
Design Suite Standard contains
AutoCAD®, Autodesk® SketchBook®
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Autodesk SketchBook Designer

Autodesk Showcase

Autodesk Mudbox

Sketch conceptual designs directly into
AutoCAD. Tap into a unique hybrid paint
and vector workflow and explore many
different design concepts. Communicate
your ideas graphically!

Quickly and easily transform your
AutoCAD designs into compelling imagery, movies, and interactive presentations
for design reviews and sales pitches.
Evaluate design variations and accelerate
feedback by reducing the need for physical prototypes and long rendering times.

Refine your models with Autodesk
Mudbox. Its powerful textured painting and digital sculpting toolset lets you
finesse the details of your ultra-realistic
models.

• Design conceptually with pencil
and paper-like sketching
• Combine and compose images
• Create graphic designs and
communications

• Accelerate the path to new business by
selling your ideas more effectively
• Reduce the time, expense, and expertise required to prepare visualizations
• Facilitate informed decision making by
viewing design options in context and
in detail

• Get fast, smooth, and accurate results
with a world-class 3D sculpting toolset
• Paint directly onto high-resolution 3D
models and see results immediately
• Create accurate normal, displacement,
and ambient occlusion maps with texture baking

Perform daylight analysis and create
cinematic-quality 3D visuals with
the animation, character, effects, and
point-and-shoot rendering and lighting
analysis tools. Convey the story behind
your design for design reviews, marketing
materials, or public outreach—before
it’s real.
• Benefit from optimized compatibility
with Autodesk and third-party solutions
• Analyze lighting scenarios with
confidence
• Bring your design to life in a highly
realistic way using 3D technology
proven in the entertainment industry
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Jean-Marc Benoit
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Autodesk Design Suite

Autodesk Design Suite

• Illustrate on a blank screen

Autodesk 3ds Max Design
(available in Premium)

Lynn Allen, Cadalyst columnist and worldwide
Autodesk Technical Evangelist, speaks to more than
30,000 users each year. For the past fifteen years she
has written a monthly column in Cadalyst magazine
called “Circles and Lines” and is the voice behind
Cadalyst’s “Tips and Tricks Tuesdays”. Lynn started
using AutoCAD® software with Release 1.4, over 20
years ago, and got her start by teaching at the corporate and collegiate level for 12 years. A sought-after
public speaker with a unique comedic style, Lynn has
served as the Autodesk University emcee for ten years
and is always one of the highest rated speakers. Her
latest book is entitled AutoCAD Professional Tips and
Techniques.
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